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Who is this guy?

• Former Nursing & Midwifery Subject Librarian – was in post here in 
TCD from Oct 2005 to March 2014

• Currently Physics & Chemistry Subject Librarian and Web Services 
Librarian

• Co-author on several articles produced by the SofNM including a 
Cochrane Review

• Advised thousands of students and staff on searches and dozens on 
systematic reviews

• E-mail: greg.sheaf@tcd.ie

• Tel: 01-8962928

http://onlinelibrary.wiley.com/doi/10.1002/14651858.CD008970.pub2/abstract
mailto:greg.sheaf@tcd.ie


• Our focus today is the search, rather than deciding on relevancy, or 
critically evaluating results, or using statistics. I’m sticking to what I 
know 

• Your searches are the entire foundation of a systematic review

• You want to be confident you have found every relevant study, to the 
best of your ability

• If the searches aren’t good enough, the whole thing is flawed



Don’t go cherrypicking

• Cherrypicking is the most common type of searching

• Searches are based on a few keywords or an author and the 
researcher mines through the information picking the articles which 
interest them (like cherries from a tree)

• Some problems 
• lack of consistency
• uncertainty whether you have “got everything”
• lack of methodology makes it impossible to replicate across databases or by 

others

• But! You have to start somewhere – can be useful to get a feel for a 
subject, and find themes and terms



Systematic searches

• Systematic searches can be used across multiple databases and by 
multiple people. Results can be replicated by others

• A core of terms is used across multiple databases, with additions and 
subtractions as necessary. For example, the part of a search looking 
for RCTs doesn’t need to be included in a database composed of RCTs

• Future researchers can carry on where you left off, for example can 
conduct a Cochrane Review using your search terms



Systematic searches versus systematic 
reviews
• *All* your searches should be done systematically, but don’t 

necessarily need to find every single relevant article or study

• For example, a search for a literature review gives a sample of 
evidence – it doesn’t aim to be totally comprehensive, instead it aims 
to find the most important works

• A systematic review is done using systematic searching, but most 
systematic searches are not systematic reviews



Why a systematic review?

• Systematic reviews are one of the hardest things you can do 
academically… but one of the most rewarding. They can find actual 
answers to real-world problems – even if that answer is “we don’t 
know the answer yet”

• Gaining popularity at thesis level - as they are literature-based only, 
they don’t require ethical approval 

• You have to become really, really good at searching

• Not just for the biomedical sciences, or RCTs within them – now used 
in many disciplines, and using qualitative studies



PRISMA (Preferred Reporting Items for Systematic 
Reviews and Meta-Analyses) Statement

“A systematic review is a review of a clearly formulated question that 
uses systematic and explicit methods to identify, select, and critically 
appraise relevant research, and to collect and analyze data from the 
studies that are included in the review. Statistical methods (meta-
analysis) may or may not be used to analyze and summarize the results 
of the included studies. Meta-analysis refers to the use of statistical 
techniques in a systematic review to integrate the results of included 
studies.”

http://prisma-statement.org/statement.htm

http://prisma-statement.org/statement.htm


Nursing and midwifery - places to look

• Biomedical databases – principally PubMed, CINAHL, PsycINFO, Cochrane, 
EMBASE. Multidisciplinary databases like Scopus, Web of Science, 
ScienceDirect… and Google Scholar. Please make sure you spell them 
correctly!

• Directly in any journals you know of, that aren’t included in the above, or 
where there is a delay – more on this later

• “Grey” literature – internal documents, reports, conference proceedings. 
These are a pain to find and just as much of a pain to search within

• Theses – use the theses databases from ProQuest via the Library
• For RCTs – the above but also CENTRAL via Cochrane, and the current trials 

databases (e.g., ISRCTN and ClinicalTrials.gov/). Support the AllTrials
initiative!

http://www.isrctn.com/
https://clinicaltrials.gov/
http://www.alltrials.net/


The elephant(s) in the room



What about Google – and Google Scholar?

• Both are great for quick and dirty searches to get started

• No-one outside Google really knows how Google assigns relevancy

• Google Scholar is brilliant to find a particular article you already know 
about, or others that cite it

• It’s very likely articles you want but don’t know about are listed in Google 
Scholar. But finding them is another matter!

• The ability to search Google Scholar like other databases just isn’t there at 
present

• Good explanation in The comparative recall of Google Scholar versus 
PubMed in identical searches for biomedical systematic reviews: a review 
of searches used in systematic reviews (Bramer et al. 2013)

http://www.systematicreviewsjournal.com/content/2/1/115


The anatomy of a systematic review
• http://prisma-statement.org/2.1.4%20-

%20PRISMA%20Flow%202009%20Diagram.pdf

http://prisma-statement.org/2.1.4 - PRISMA Flow 2009 Diagram.pdf


Tips, tricks and things to look out 
for…



PICO is your friend

• P=Patient or Population

• I=Intervention or Issue

• C=Comparison (often optional)

• O=Outcome/Measurement

• For example:

“In college students (P) are nicotine-replacement interventions (I) 
effective compared to placebo (C) in increasing smoking cessation (O)?”



Even when a journal *is* indexed in a 
database, there may be a delay…
• For example, I’m currently involved in a project looking at chaplaincy 

services in hospitals

• One of the key databases for this is a theological database compiled by the 
American Theological Library Association (ATLA)

• This indexes the relevant periodical, Journal of Pastoral Care & Counseling

• In January 2015 the latest issue is 68:4 December 2014. But only articles up 
to March 2014, 68:1, are appearing in the database

• So you have to search on the journals website (putting in a date limit) to 
get the newer articles. Three issues worth

• How are you supposed to know this?



“Hard” searches are easy, “soft” searches are 
hard
• Searches for well-defined terms – conditions, for instance – are 

normally quite simple. They generally have a standardised index term, 
and only a few synonyms

• But searches for “softer” terms are much, much harder, as there are 
often so many variations of the idea it could be 

• I’m looking for “people’s experiences of…”

• Most searchers will only search for the exact word “experiences”

• But what words could it be?

• Have a think, write them down!



“Hard” searches are easy, “soft” searches are 
hard II

• As well as “experiences”, ANY of the below could be used 
instead in an article:

• experience OR experiences OR experienced OR view OR 
views OR viewpoint OR viewpoints OR perception OR 
perceptions OR perceive OR attitude OR attitudes OR belief 
OR beliefs

• …you can probably think of more!



The dubious joy of PubMed’s autosearching

• You are looking in PubMed for articles on obstetric labour. You type in 
labour

• It automatically searches for labour *and* labor – GREAT!

• But it also automatically searches for work – both as a term 
anywhere, and as the MeSH term work – NOT SO GREAT

• I think that over 90% of the labor results are not to do with obstetric 
labour

• Aaargh!



Labour=Labor=Work in PubMed
• All the results for labour appear within the results for labor (proved by #10)

• Unfortunately, so do all the results for work (proved by #12)

• Only a small proportion of the results for labor are actually for that word; most are 
for work

• You can see this in search #13 - (labor OR labour) NOT work. Note, this excludes 
results that mention both labor/labour *and* work in the same record, so it’s 
imperfect



Fun with midwifery…

• Search for midwifery

• Search for midwife

• Search for midwives

• What’s going on???



Fun with midwifery II

• Search for midwifery = "midwifery"[MeSH Terms] OR 
"midwifery"[All Fields]

• Search for midwife = "midwifery"[MeSH Terms] OR 
"midwifery"[All Fields] OR "midwife"[All Fields]

• Search for midwives = "midwifery"[MeSH Terms] OR 
"midwifery"[All Fields] OR "midwives"[All Fields]



Fun with midwifery III

• Searching for any of the terms midwifery/midwife/midwives 
automatically searches for midwifery as a word anywhere in 
a record. This is not helpful…

• ….as it is also searching the Author Affiliation field, and 
getting any record that e.g., is noted as being written by 
someone at a “School of Nursing and Midwifery”

• Note that midwives *doesn’t* search for midwife and vice 
versa





School’s out…

• Researchers looking at issues affecting children often search for the 
word school

• Of the 2443966 results for school on 19/01/15, 2228493 do not 
mention school in the title, abstract or as a MeSH term

• Over 90% of the two-and-a-half million articles that have been added 
to a search looking for info on children are likely to be irrelevant



Truncation isn’t necessarily a good idea

• PubMed allows you to use an asterisk to find records that mention 
that word or anything that has that “stem”. This seems like a clever 
way to search, right?

• It turns off the automatic mapping of terms that occurs behind the 
scenes (so brain cancer* will not find the MeSH term Brain 
Neoplasms or include any of the more specific subterms, such as 
Cerebral Ventricle Neoplasms, Neurocytoma, or Supratentorial
Neoplasms). OK so long as you realise that…

• Retrieval is restricted to the first 600 variations of the truncated term

• How can there be 600 variations of something???





Those first 600 variations!
• labor[All Fields] OR labor'[All Fields] OR labor''[All Fields] OR labor's[All Fields] OR labora[All Fields] OR labora2[All Fields] OR labora3bi[All Fields] OR laboraatoire[All Fields] OR laboraatoriumsfragen[All Fields] OR laborability[All Fields] OR laborable[All Fields] OR laborableitung[All Fields] OR 

laborables[All Fields] OR laborabories[All Fields] OR laborabory[All Fields] OR laborabteilung[All Fields] OR laborabtory[All Fields] OR laboracios[All Fields] OR laboractory[All Fields] OR laborada[All Fields] OR laborador[All Fields] OR laboraerzte[All Fields] OR laboraf[All Fields] OR 
laboraforiet[All Fields] OR laborafory[All Fields] OR laboragory[All Fields] OR laborai[All Fields] OR laboraire[All Fields] OR laborais[All Fields] OR laboral[All Fields] OR laborales[All Fields] OR laboralltag[All Fields] OR laboralmente[All Fields] OR laboralory[All Fields] OR laboraly[All Fields] OR 
laboramtoire[All Fields] OR laboran[All Fields] OR laboranalysen[All Fields] OR laboranalytical[All Fields] OR laboranalytik[All Fields] OR laboranalytische[All Fields] OR laboranalytischer[All Fields] OR laborandi[All Fields] OR laboranordnung[All Fields] OR laboranskepzo[All Fields] OR laborant[All 
Fields] OR laboranta[All Fields] OR laborantam[All Fields] OR laborantami[All Fields] OR laborante[All Fields] OR laborantek[All Fields] OR laboranten[All Fields] OR laborantens[All Fields] OR laboranter[All Fields] OR laboranterne[All Fields] OR laboranti[All Fields] OR laborantin[All Fields] OR 
laborantine[All Fields] OR laborantines[All Fields] OR laborantinnen[All Fields] OR laborantins[All Fields] OR laborantki[All Fields] OR laborantky[All Fields] OR laborantov[All Fields] OR laborantska[All Fields] OR laborantskolan[All Fields] OR laborantskolans[All Fields] OR laborantskolen[All Fields] 
OR laborantu[All Fields] OR laboranty[All Fields] OR laboraoire[All Fields] OR laboraorio[All Fields] ORtlaboraory[All Fields] OR laboraotires[All Fields] OR laboraotory[All Fields] OR laboraotries[All Fields] OR laboraotry[All Fields] OR laboraoty[All Fields] OR laboraoynkh[All Fields] OR 
laboraratoire[All Fields] OR laborarbeit[All Fields] OR laborarbeiten[All Fields] OR laborare[All Fields] OR laboraries[All Fields] OR laborariiakh[All Fields] OR laborario[All Fields] OR laborarium[All Fields] OR laborarnich[All Fields] OR laboraroire[All Fields] OR laboraroite[All Fields] OR 
laborarori[All Fields] OR laborarories[All Fields] OR laborarorio[All Fields] OR laborarorium[All Fields] OR laborarory[All Fields] OR laboraroy[All Fields] OR laborartefakt[All Fields] OR laborartefakts[All Fields] OR laborartoire[All Fields] OR laborartorio[All Fields] OR laborartory[All Fields] OR 
laborartoty[All Fields] OR laborary[All Fields] OR laborarzt[All Fields] OR laborarzte[All Fields] OR laborarzten[All Fields] OR laborarztliche[All Fields] OR laborarztpraxis[All Fields] OR laboras[All Fields] OR laborat[All Fields] OR laborat'orio[All Fields] OR laborat'orium[All Fields] OR 
laborat'oriumi[All Fields] OR laborat'orna[All Fields] OR laborat'orne[All Fields] OR laborat'ornej[All Fields] OR laborat'ornou[All Fields] OR laborat'ornych[All Fields] OR laborat6rio[All Fields] OR laborataire[All Fields] OR laborataory[All Fields] OR laboratario[All Fields] OR laboratary[All Fields] 
OR laboratay[All Fields] OR laboratcire[All Fields] OR laboratcry[All Fields] OR laboratdrio[All Fields] OR laborategia[All Fields] OR laborateri[All Fields] OR laboraterio[All Fields] OR laboratery[All Fields] OR laboratgory[All Fields] OR laborathory[All Fields] OR laboratial[All Fields] OR 
laboratician[All Fields] OR laboratiere[All Fields] OR laboraties[All Fields] OR laboratinserm[All Fields] OR laboratio[All Fields] OR laboration[All Fields] OR laborationen[All Fields] OR laborations[All Fields] OR laboratiore[All Fields] OR laboratiorial[All Fields] OR laboratiorien[All Fields] OR 
laboratiories[All Fields] OR laboratioriia[All Fields] OR laboratiorio[All Fields] OR laboratioriumstiere[All Fields] OR laboratire[All Fields] OR laboratiries[All Fields] OR laboratirio[All Fields] OR laboratiry[All Fields] OR laboratium[All Fields] OR laborativ[All Fields] OR laborativa[All Fields] OR 
laborative[All Fields] OR laborativos[All Fields] OR laboratjory[All Fields] OR laboratmy[All Fields] OR laboratnogo[All Fields] OR laboratnornoi[All Fields] OR laboratnrni[All Fields] OR laborato[All Fields] OR laborato6rach[All Fields] OR laborato6ri[All Fields] OR laborato6rich[All Fields] OR 
laboratoaire[All Fields] OR laboratoare[All Fields] OR laboratoarele[All Fields] OR laboratoarelor[All Fields] OR laboratoarnykh[All Fields] OR laboratoary[All Fields] OR laboratoby[All Fields] OR laboratof[All Fields] OR laboratogs[All Fields] OR laboratogy[All Fields] OR laboratoie[All Fields] OR 
laboratoiere[All Fields] OR laboratoies[All Fields] OR laboratoio[All Fields] OR laboratoir[All Fields] OR laboratoire[All Fields] OR laboratoire'innovation[All Fields] OR laboratoired[All Fields] OR laboratoired'[All Fields] OR laboratoired'anthropologie[All Fields] OR laboratoired'immunologie[All 
Fields] OR laboratoirede[All Fields] OR laboratoiredes[All Fields] OR laboratoiremassan[All Fields] OR laboratoireprover[All Fields] OR laboratoirer[All Fields] OR laboratoires[All Fields] OR laboratoiri[All Fields] OR laboratoiries[All Fields] OR laboratoirio[All Fields] OR laboratoirium[All Fields] OR 
laboratoiro[All Fields] OR laboratoirre[All Fields] OR laboratoiry[All Fields] OR laboratoite[All Fields] OR laboratoive[All Fields] OR laboratology[All Fields] OR laboratoly[All Fields] OR laboratomicronrio[All Fields] OR laboratono[All Fields] OR laboratonum[All Fields] OR laboratonykh[All Fields] 
OR laboratoorio[All Fields] OR laboratoory[All Fields] OR laboratopium[All Fields] OR laborator[All Fields] OR laboratoraeundersogelser[All Fields] OR laboratoraia[All Fields] OR laboratorally[All Fields] OR laboratoratoire[All Fields] OR laboratoratorio[All Fields] OR laboratoratory[All Fields] OR 
laboratoray[All Fields] OR laboratorboi[All Fields] OR laboratore[All Fields] OR laboratoreis[All Fields] OR laboratoremi[All Fields] OR laboratoren[All Fields] OR laboratores[All Fields] OR laboratorg[All Fields] OR laboratori[All Fields] OR laboratoria[All Fields] OR laboratoriach[All Fields] OR 
laboratoriahps[All Fields] OR laboratoriais[All Fields] OR laboratoriakh[All Fields] OR laboratorial[All Fields] OR laboratoriale[All Fields] OR laboratoriales[All Fields] OR laboratorially[All Fields] OR laboratorian[All Fields] OR laboratorian's[All Fields] OR laboratorians[All Fields] OR 
laboratorians'[All Fields] OR laboratorias[All Fields] OR laboratoriasis[All Fields] OR laboratoric[All Fields] OR laboratorical[All Fields] OR laboratorically[All Fields] OR laboratorich[All Fields] OR laboratorie[All Fields] OR laboratorieanalyse[All Fields] OR laboratorieanalysene[All Fields] OR 
laboratorieanalyser[All Fields] OR laboratorieanalysers[All Fields] OR laboratorieansatte[All Fields] OR laboratorieapparat[All Fields] OR laboratoriearbeid[All Fields] OR laboratoriearbete[All Fields] OR laboratorieassistent[All Fields] OR laboratorieassistentelever[All Fields] OR 
laboratorieassistenter[All Fields] OR laboratorieassistenterna[All Fields] OR laboratorieassistenternas[All Fields] OR laboratorieassistenters[All Fields] OR laboratorieassistentutbildningen[All Fields] OR laboratorieavdelingen[All Fields] OR laboratoriebruk[All Fields] OR laboratoriebygget[All 
Fields] OR laboratoriecenteret[All Fields] OR laboratoriecentret[All Fields] OR laboratoriecentrum[All Fields] OR laboratoriedata[All Fields] OR laboratoriediagnosen[All Fields] OR laboratoriediagnostik[All Fields] OR laboratoriediagnostiken[All Fields] OR laboratoriediagnostikk[All Fields] OR 
laboratoriediagnostiska[All Fields] OR laboratoriediagnostiskt[All Fields] OR laboratoriedjur[All Fields] OR laboratoriedyrs[All Fields] OR laboratorieerfarenheter[All Fields] OR laboratorieforbrug[All Fields] OR laboratorieforholdene[All Fields] OR laboratorieforskning[All Fields] OR 
laboratorieforskningen[All Fields] OR laboratorieforskningens[All Fields] OR laboratorieforsog[All Fields] OR laboratorieforsok[All Fields] OR laboratoriefund[All Fields] OR laboratoriefunn[All Fields] OR laboratoriefynd[All Fields] OR laboratoriei[All Fields] OR laboratorieinformatik[All Fields] OR 
laboratorieinstrument[All Fields] OR laboratoriekemist[All Fields] OR laboratoriekontroll[All Fields] OR laboratorielaekare[All Fields] OR laboratorielakare[All Fields] OR laboratorielista[All Fields] OR laboratoriema[All Fields] OR laboratoriemaessige[All Fields] OR laboratoriemaessigt[All Fields] 
OR laboratoriemassig[All Fields] OR laboratoriemateriale[All Fields] OR laboratoriemedicin[All Fields] OR laboratoriemedicinen[All Fields] OR laboratoriemedicinska[All Fields] OR laboratoriemedicinske[All Fields] OR laboratoriemedicinskt[All Fields] OR laboratoriemedisin[All Fields] OR 
laboratoriemedisins[All Fields] OR laboratoriemedisinsk[All Fields] OR laboratoriemessig[All Fields] OR laboratoriemessige[All Fields] OR laboratoriemetoder[All Fields] OR laboratoriemetodik[All Fields] OR laboratoriemiljo[All Fields] OR laboratorien[All Fields] OR laboratorienes[All Fields] OR 
laboratorieoverfort[All Fields] OR laboratorieparametre[All Fields] OR laboratorieproblemer[All Fields] OR laboratorieproover[All Fields] OR laboratorieprov[All Fields] OR laboratorieprover[All Fields] OR laboratorier[All Fields] OR laboratorierad[All Fields] OR laboratorieresultat[All Fields] OR 
laboratorieresultaten[All Fields] OR laboratorieresultater[All Fields] OR laboratorieresurser[All Fields] OR laboratorieresurserna[All Fields] OR laboratorierna[All Fields] OR laboratoriernas[All Fields] OR laboratorierne[All Fields] OR laboratories[All Fields] OR laboratories'[All Fields] OR 
laboratories'accreditation[All Fields] OR laboratories35[All Fields] OR laboratories556[All Fields] OR laboratoriesadvanced[All Fields] OR laboratoriesdepartment[All Fields] OR laboratoriesdiscipline[All Fields] OR laboratoriesdivision[All Fields] OR laboratoriesenteret[All Fields] OR 
laboratorieservice[All Fields] OR laboratoriesfaculty[All Fields] OR laboratoriesh[All Fields] OR laboratoriesin[All Fields] OR laboratoriesituationen[All Fields] OR laboratoriesjukdom[All Fields] OR laboratorieskao[All Fields] OR laboratorieslilly[All Fields] OR laboratorieslivermore[All Fields] OR 
laboratoriesm[All Fields] OR laboratoriesp[All Fields] OR laboratoriesradboud[All Fields] OR laboratoriesresearch[All Fields] OR laboratoriess[All Fields] OR laboratoriesschool[All Fields] OR laboratoriesscientific[All Fields] OR laboratoriesthe[All Fields] OR laboratoriestodd[All Fields] OR 
laboratoriesuniversity[All Fields] OR laboratoriesvar[All Fields] OR laboratoriesvaret[All Fields] OR laboratorieswp75a[All Fields] OR laboratoriesykepleierne[All Fields] OR laboratoriet[All Fields] OR laboratorietandteknikere[All Fields] OR laboratorieteknik[All Fields] OR laboratorieteknikere[All 
Fields] OR laboratorieteknisk[All Fields] OR laboratorietekniska[All Fields] OR laboratorieteknologi[All Fields] OR laboratorietest[All Fields] OR laboratorietester[All Fields] OR laboratorietjanster[All Fields] OR laboratorietjenester[All Fields] OR laboratoriets[All Fields] OR 
laboratorieundersegelser[All Fields] OR laboratorieundersogelse[All Fields] OR laboratorieundersogelser[All Fields] OR laboratorieundersokelse[All Fields] OR laboratorieundersokelser[All Fields] OR laboratorieundersokning[All Fields] OR laboratorieundersokningar[All Fields] OR 
laboratorieundersokningars[All Fields] OR laboratorieundersookelser[All Fields] OR laboratorieutfall[All Fields] OR laboratorieutredning[All Fields] OR laboratorieutrustning[All Fields] OR laboratorievarden[All Fields] OR laboratorieverksamhet[All Fields] OR laboratorieverksamheten[All Fields] 
OR laboratorieverksamhetens[All Fields] OR laboratorievetenskap[All Fields] OR laboratorievirksomhet[All Fields] OR laboratorievirksomheten[All Fields] OR laboratorieydelsers[All Fields] OR laboratorii[All Fields] OR laboratoriia[All Fields] OR laboratoriiakh[All Fields] OR laboratoriiam[All 
Fields] OR laboratoriiami[All Fields] OR laboratoriiata[All Fields] OR laboratoriikh[All Fields] OR laboratoriite[All Fields] OR laboratoriiu[All Fields] OR laboratorij[All Fields] OR laboratorija[All Fields] OR laboratorijama[All Fields] OR laboratorije[All Fields] OR laboratoriji[All Fields] OR 
laboratorijih[All Fields] OR laboratorijima[All Fields] OR laboratorijose[All Fields] OR laboratorijska[All Fields] OR laboratorijske[All Fields] OR laboratorijski[All Fields] OR laboratorijskih[All Fields] OR laboratorijskim[All Fields] OR laboratorijsko[All Fields] OR laboratorijskog[All Fields] OR 
laboratorijskoj[All Fields] OR laboratorijskom[All Fields] OR laboratorijsku[All Fields] OR laboratoriju[All Fields] OR laboratorijumski[All Fields] OR laboratorily[All Fields] OR laboratorim[All Fields] OR laboratorin'e[All Fields] OR laboratorin'es[All Fields] OR laboratoriniai[All Fields] OR 
laboratorinis[All Fields] OR laboratorio[All Fields] OR laboratorioalan[All Fields] OR laboratorioarvot[All Fields] OR laboratoriocac[All Fields] OR laboratoriode[All Fields] OR laboratoriodecomunicacion[All Fields] OR laboratoriodequimica[All Fields] OR laboratoriodiagnostiikan[All Fields] OR 
laboratoriodiagnostiikassa[All Fields] OR laboratoriodiagnostiikasta[All Fields] OR laboratoriodiagnostiikka[All Fields] OR laboratoriodiagnostiikkaa[All Fields] OR laboratoriodiagnostiikkaan[All Fields] OR laboratoriogenoma[All Fields] OR laboratoriohidalgo[All Fields] OR laboratoriohoitaja[All 
Fields] OR laboratorioiden[All Fields] OR laboratoriokeskus[All Fields] OR laboratoriokokeena[All Fields] OR laboratoriokokeet[All Fields] OR laboratoriokokeisiin[All Fields] OR laboratoriolaaketiede[All Fields] OR laboratoriolace[All Fields] OR laboratoriolle[All Fields] OR laboratorioloydokset[All 
Fields] OR laboratorion[All Fields] OR laboratorionacional[All Fields] OR laboratorionch[All Fields] OR laboratorionjohtaja[All Fields] OR laboratorioon[All Fields] OR laboratoriopalvelut[All Fields] OR laboratorios[All Fields] OR laboratoriosairaanhoitajia[All Fields] OR laboratoriosecosur[All 
Fields] OR laboratorioseurannassa[All Fields] OR laboratorioslarrasa[All Fields] OR laboratoriosrubio[All Fields] OR laboratoriossa[All Fields] OR laboratoriosta[All Fields] OR laboratoriot[All Fields] OR laboratoriotasc[All Fields] OR laboratoriotoiminnan[All Fields] OR laboratoriotulosten[All 
Fields] OR laboratoriotutkimukset[All Fields] OR laboratoriotutkimuksia[All Fields] OR laboratoriotutkimuksista[All Fields] OR laboratoriotutkimusta[All Fields] OR laboratoriotutkimusten[All Fields] OR laboratoriouliuosten[All Fields] OR laboratorioumsmedizin[All Fields] OR 
laboratorioumsmethoden[All Fields] OR laboratoriously[All Fields] OR laboratoriow[All Fields] OR laboratorire[All Fields] OR laboratorires[All Fields] OR laboratoris[All Fields] OR laboratorische[All Fields] OR laboratoriska[All Fields] OR laboratoriske[All Fields] OR laboratoriskih[All Fields] OR 
laboratoriskoj[All Fields] OR laboratorisku[All Fields] OR laboratoriso[All Fields] OR laboratorist[All Fields] OR laboratorista[All Fields] OR laboratoristas[All Fields] OR laboratoristi[All Fields] OR laboratoristic[All Fields] OR laboratoristica[All Fields] OR laboratoristiche[All Fields] OR 
laboratoristichypocalcemia[All Fields] OR laboratoristici[All Fields] OR laboratoristico[All Fields] OR laboratoristics[All Fields] OR laboratorists[All Fields] OR laboratoriu[All Fields] OR laboratoriui[All Fields] OR laboratorium[All Fields] OR laboratorium's[All Fields] OR laboratorium1[All Fields] OR 
laboratoriuma[All Fields] OR laboratoriumaiban[All Fields] OR laboratoriumainak[All Fields] OR laboratoriumanak[All Fields] OR laboratoriumanalyse[All Fields] OR laboratoriumanalysen[All Fields] OR laboratoriumartsen[All Fields] OR laboratoriumban[All Fields] OR laboratoriumbepalingen[All 
Fields] OR laboratoriumbevindingen[All Fields] OR laboratoriumbijzonderheden[All Fields] OR laboratoriumcentrum[All Fields] OR laboratoriumcontrole[All Fields] OR laboratoriumdiagnose[All Fields] OR laboratoriumdiagnostiek[All Fields] OR laboratoriumdiagnostik[All Fields] OR 
laboratoriumdiagnostische[All Fields] OR laboratoriumdieren[All Fields] OR laboratoriumeine[All Fields] OR laboratoriumervaringen[All Fields] OR laboratoriumexperiment[All Fields] OR laboratoriumfout[All Fields] OR laboratoriumgegevens[All Fields] OR laboratoriumgeneekunde[All Fields] OR 
laboratoriumgeneeskunde[All Fields] OR laboratoriumi[All Fields] OR laboratoriumig[All Fields] OR laboratoriumland[All Fields] OR laboratoriummethoden[All Fields] OR laboratoriummonsters[All Fields] OR laboratoriumok[All Fields] OR laboratoriumokban[All Fields] OR 
laboratoriumonderzoek[All Fields] OR laboratoriumonderzoekingen[All Fields] OR laboratoriumot[All Fields] OR laboratoriumpersoneel[All Fields] OR laboratoriums[All Fields] OR laboratoriumsanalysen[All Fields] OR laboratoriumsapparatur[All Fields] OR laboratoriumsarbeit[All Fields] OR 
laboratoriumsarbeiten[All Fields] OR laboratoriumsbedingungen[All Fields] OR laboratoriumsbefunde[All Fields] OR laboratoriumsbefunden[All Fields] OR laboratoriumsbefundung[All Fields] OR laboratoriumsbehelfe[All Fields] OR laboratoriumsbestimmungen[All Fields] OR 
laboratoriumsdaten[All Fields] OR laboratoriumsdermatomykose[All Fields] OR laboratoriumsdiagnose[All Fields] OR laboratoriumsdiagnosen[All Fields] OR laboratoriumsdiagnostik[All Fields] OR laboratoriumsdiagnostische[All Fields] OR laboratoriumsdiagnostischen[All Fields] OR 
laboratoriumsdiagnostischer[All Fields] OR laboratoriumsdiagnostoik[All Fields] OR laboratoriumsdiangostik[All Fields] OR laboratoriumsdienst[All Fields] OR laboratoriumserfahrungen[All Fields] OR laboratoriumsergebnisse[All Fields] OR laboratoriumsergebnissen[All Fields] OR 
laboratoriumsexperimentes[All Fields] OR laboratoriumsfermenter[All Fields] OR laboratoriumsfilm[All Fields] OR laboratoriumsfrosche[All Fields] OR laboratoriumsgerat[All Fields] OR laboratoriumsgeschwuelsten[All Fields] OR laboratoriumsglaswaren[All Fields] OR laboratoriumsgrossen[All 
Fields] OR laboratoriumsinfektion[All Fields] OR laboratoriumsinfektionen[All Fields] OR laboratoriumsinterferometer[All Fields] OR laboratoriumskolonie[All Fields] OR laboratoriumskontrolle[All Fields] OR laboratoriumskosten[All Fields] OR laboratoriumskulturen[All Fields] OR 
laboratoriumsleiters[All Fields] OR laboratoriumsmassige[All Fields] OR laboratoriumsmassstab[All Fields] OR laboratoriumsmaus[All Fields] OR laboratoriumsmause[All Fields] OR laboratoriumsmausen[All Fields] OR laboratoriumsmechanisierung[All Fields] OR laboratoriumsmed[All Fields] OR 
laboratoriumsmedizin[All Fields] OR laboratoriumsmedizinische[All Fields] OR laboratoriumsmedizinzentrallabor[All Fields]



The first few so you can read them…
• labor[All Fields] OR labor'[All Fields] OR labor''[All Fields] OR labor's[All Fields] OR labora[All Fields] OR labora2[All Fields] OR 

labora3bi[All Fields] OR laboraatoire[All Fields] OR laboraatoriumsfragen[All Fields] OR laborability[All Fields] OR laborable[All Fields] OR 
laborableitung[All Fields] OR laborables[All Fields] OR laborabories[All Fields] OR laborabory[All Fields] OR laborabteilung[All Fields] OR 
laborabtory[All Fields] OR laboracios[All Fields] OR laboractory[All Fields] OR laborada[All Fields] OR laborador[All Fields] OR 
laboraerzte[All Fields] OR laboraf[All Fields] OR laboraforiet[All Fields] OR laborafory[All Fields] OR laboragory[All Fields] OR laborai[All 
Fields] OR laboraire[All Fields] OR laborais[All Fields] OR laboral[All Fields] OR laborales[All Fields] OR laboralltag[All Fields] OR 
laboralmente[All Fields] OR laboralory[All Fields] OR laboraly[All Fields] OR laboramtoire[All Fields] OR laboran[All Fields] OR 
laboranalysen[All Fields] OR laboranalytical[All Fields] OR laboranalytik[All Fields] OR laboranalytische[All Fields] OR laboranalytischer[All 
Fields] OR laborandi[All Fields] OR laboranordnung[All Fields] OR laboranskepzo[All Fields] OR laborant[All Fields] OR laboranta[All Fields] 
OR laborantam[All Fields] OR laborantami[All Fields] OR laborante[All Fields] OR laborantek[All Fields] OR laboranten[All Fields] OR 
laborantens[All Fields] OR laboranter[All Fields] OR laboranterne[All Fields] OR laboranti[All Fields] OR laborantin[All Fields] OR 
laborantine[All Fields] OR laborantines[All Fields] OR laborantinnen[All Fields] OR laborantins[All Fields] OR laborantki[All Fields] OR 
laborantky[All Fields] OR laborantov[All Fields] OR laborantska[All Fields] OR laborantskolan[All Fields] OR laborantskolans[All Fields] OR 
laborantskolen[All Fields] OR laborantu[All Fields] OR laboranty[All Fields] OR laboraoire[All Fields] OR laboraorio[All Fields] OR 
laboraory[All Fields] OR laboraotires[All Fields] OR laboraotory[All Fields] OR laboraotries[All Fields] OR laboraotry[All Fields] OR 
laboraoty[All Fields] OR laboraoynkh[All Fields] OR laboraratoire[All Fields] OR laborarbeit[All Fields] OR laborarbeiten[All Fields] OR 
laborare[All Fields] OR laboraries[All Fields] OR laborariiakh[All Fields] OR laborario[All Fields] OR laborarium[All Fields] OR 
laborarnich[All Fields] OR laboraroire[All Fields] OR laboraroite[All Fields] OR laborarori[All Fields] OR laborarories[All Fields] OR 
laborarorio[All Fields] OR laborarorium[All Fields] OR laborarory[All Fields] OR laboraroy[All Fields] OR laborartefakt[All Fields] OR 
laborartefakts[All Fields] OR laborartoire[All Fields] OR laborartorio[All Fields] OR laborartory[All Fields] OR laborartoty[All Fields] OR 
laborary[All Fields] OR laborarzt[All Fields] OR laborarzte[All Fields] OR laborarzten[All Fields] OR laborarztliche[All Fields] OR 
laborarztpraxis[All Fields] OR laboras[All Fields] OR laborat[All Fields] OR laborat'orio[All Fields] OR laborat'orium[All Fields] OR 
laborat'oriumi[All Fields] OR laborat'orna[All Fields] OR laborat'orne[All Fields] OR laborat'ornej[All Fields] OR laborat'ornou[All Fields] 
OR laborat'ornych[All Fields] OR laborat6rio[All Fields] OR laborataire[All Fields] OR laborataory[All Fields] OR laboratario[All Fields] OR 
laboratary[All Fields] OR laboratay[All Fields] OR laboratcire[All Fields] OR laboratcry[All Fields] OR laboratdrio[All Fields] OR 
laborategia[All Fields] OR laborateri[All Fields] OR laboraterio[All Fields] OR laboratery[All Fields] OR laboratgory[All Fields] OR 
laborathory[All Fields] OR laboratial[All Fields] OR laboratician[All Fields] OR laboratiere[All Fields] OR laboraties[All Fields] OR 
laboratinserm[All Fields] OR laboratio[All Fields] OR laboration[All Fields] OR laborationen[All Fields] OR laborations[All Fields] OR 
laboratiore[All Fields] OR laboratiorial[All Fields] OR laboratiorien[All Fields] OR laboratiories[All Fields] OR laboratioriia[All Fields] OR 
laboratiorio[All Fields] OR laboratioriumstiere[All Fields] OR laboratire[All Fields] OR laboratiries[All Fields] OR laboratirio[All Fields] OR 
laboratiry[All Fields] OR laboratium[All Fields] OR laborativ[All Fields] OR laborativa[All Fields] OR laborative[All Fields] OR laborativos[All 
Fields] OR laboratjory[All Fields] OR laboratmy[All Fields] OR laboratnogo[All Fields] OR laboratnornoi[All Fields] OR laboratnrni[All 
Fields] OR……………..



So what are you supposed to do?



Slice it up

• Divide up your search into its constituent parts. Use PICO as a start:

• P=Patient or Population

• I=Intervention or Issue

• C=Comparison (often optional)

• O=Outcome/Measurement

• Another useful variable is time



Take control

• Always see if the database uses “controlled vocabulary”. Basically, 
standardised subject terms

• In PubMed, MeSH – Medical Subject Headings

• In CINAHL, CINAHL Headings

• In PsycINFO, PsycINFO Descriptors

• You need to know whether these terms are automatically “exploded” 
or not. PubMed auto-explodes, CINAHL doesn’t

• The description may list “entry terms” or “used for” words, that can 
be used as keyword synonyms



Think of synonyms 

• Use a thesaurus

• Ask a friend or colleague for five words that mean the same as X

• You might see more when you are looking at the “entry terms” for a 
controlled vocabulary item. Some will be the same words in different 
order, or as plurals. Pick out the unique words



Entry terms for MeSH term Rubella – as found by 
typing in German Measles into MeSH database 



Keywords from the Rubella MeSH entry

• three day OR German
• measles OR measle
• rubella OR rubellas

• You want:
three day OR German
AND 
measles OR measle
AND THEN OR
rubella OR rubellas



“Measle”? “Rubellas”? Really?

• In PubMed, about five entries (from 24,000,000 plus) seem to only
have measle but not measles in the title or abstract, nor a measles-
relevant MeSH term

• Rubellas only appears in one title/abstract – and so does rubella in 
that record anyway

• Well, you can’t be accused of not being thorough!



Search for your keywords

• Normally best to limit to title and abstract, if you are also running 
controlled vocabulary searches

• Note that in PubMed this automatically runs a phrase search:

“folic acid”[Title/Abstract]

=

folic acid[Title/Abstract]

=/=

folic[Title/Abstract] AND acid[Title/Abstract]



Putting it all together

In my experience, the most comprehensive searches are:

• First idea - Search for one concept (not necessarily one word) at a time, 
then combine all the searches on that idea into a “super search” on that 
idea 

• Use a combination of controlled vocabulary searches and keyword 
searches for multiple synonyms, limited to title and abstract in most cases. 
Add them together with OR

• Do the same for the next idea

• Keep going…

• Then add the “super searches” together with AND

• Export results into reference manager software



Say it only once – deduplication of results 
using EndNote
• Deduplicate results *before* you decide on relevance, so you only need to 

decide on relevance once for each article
• Create a new Library for every database and have only it open; send the 

results into it
• In that EndNote Library, select all the records and make sure they all have 

the database name under Name of Database – if not, select them all, go to 
Tools > Change/Move/Copy Fields, and under the Name of Database field, 
choose Replace whole field with: and add the name of the database there

• Close the Library, move on to the next database
• Once you have separate Libraries created for each database, create a new 

blank “master Library”
• You can create Smart Groups to automatically display how many results 

you have from each database



Deduplication of results using EndNote II

• Decide which order you are going to import the databases’ Libraries. This is 
important as it will decide which of the duplicate results you will keep

• File > Import > File. Choose the Library (a .enl file), under Import Options
select EndNote Library. Tell it to Discard Duplicates

• What counts as a duplicate is decided under Edit > Preferences > 
Duplicates. By default matches must have the same authors, year and title, 
but variants in spacing and punctuation are ignored. You can make changes 
here to widen or narrow the definition

• You can find duplicates later by going to References > Find Duplicates
• Trust me, there will still be duplicates in there. Order the whole list by 

author, or by title, to help see them. All things being equal, keep the one 
with the lower record number – this is the one you imported first, decided 
by which database you imported before the other



Separate the wheat from the chaff

• Groups > Create Group Set. Call it Relevant?

• Add groups to it, for example, Irrelevant and Relevant

• Click in to Unfiled. This is important!

• Set the citation style to Annotated, and the Reference Panel to 
Preview. This shows you any abstracts that came in with the record

• Work your way through the Unfiled records, moving them to 
Irrelevant and Relevant, until there are no records left without a 
group. That way you’ve made a decision about each record



Sanity check

• Do you already know of a really good article?

• Does the search you’ve constructed pick it up?

If no…

• Is the journal in the database? Are others from that issue in 
it? If yes:
• What term(s) are missing from your search that would have 

triggered it to appear? If looking at it as a PDF or webpage, use 
CRTL + F (Command + F on a Mac) to search for your terms



Finally

• Good searches are done when you are methodical – so you should do 
systematic searches even if you aren’t doing a systematic review - but 
with a dash of art as well as science

• You start to know how a particular database works - experience 
imparts intuition as to when a search is working or not

• Or maybe I’ve just been doing this for too long 



For more help…



Jessica Eustace-Cook

• Nursing & Midwifery Subject Librarian

• E-mail: eustacj@tcd.ie

• Tel: 01-8964916

• Office Hours Mon, Tues, Thurs 09:00-16:00
• Meetings by appointment only
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